Installing Q Local Software
and Attaching the Report Counter

These instructions help ensure that your software installation proceeds smoothly as it interacts with the operating system and firewall/anti-virus/anti-spyware software. These instructions also provide Q Local tips and troubleshooting instructions.

Contents

Quick Installation or Upgrade Instructions ................................................................. 2
Check System Requirements ............................................................................... 2
Disable Firewall/Anti-Virus/Anti-Spyware Software ............................................................. 3
Close Any Software Applications ............................................................................ 4
Installing Q Local 3 (Existing 2.x Customers) .................................................................. 4
Installing or Upgrading Q Local 3 (New or Existing Q Local 3 Customers) .......................................... 7
Permissions for Q Local Software ........................................................................... 7
Install Internet Explorer for On-Screen Administration ......................................................... 8
Install QuickTime Audio Player for Audio Administration ........................................................ 8
Install Adobe Reader Software .............................................................................. 9
Attach the Report Counter ................................................................................. 9
Start Q Local Software ................................................................................... 10

Important How-To Instructions .......................................................................... 10
How to Exit and Save an On-Screen Assessment: Administrator Code ............................................ 10
How to Get Help ........................................................................................ 11
How to Check Report Inventory ............................................................................ 11
How to Connect the Scanner .............................................................................. 11
How to Transfer Data ..................................................................................... 12
How to Back Up the System ............................................................................. 13
How to Install Audio ..................................................................................... 14
How to Re-Install the Software ............................................................................ 16

Additional Information for Network Installations ................................................... 17
Network Configurations .................................................................................. 17
Installing Q Local Network Version Software ................................................................. 19
Provide Q Local Full Access in Firewall Software ............................................................. 21
Ports Utilized by Q Local System 3 Network .................................................................. 21
Troubleshooting the Connection to the Q Local Database ...................................................... 22
Troubleshooting the Connection to the Q Local Shared Report Counter .......................................... 23
Side-by-Side Network Installations for Q Local System 3 ....................................................... 24
Quick Installation or Upgrade Instructions

In most cases, you can install or upgrade Q Local software by following these steps:

- Check the system requirements
- Disable firewall/anti-virus/anti-spyware software
- Close any software applications
- Install or upgrade Q Local software

The following pages describe these steps. If you encounter problems, follow the relevant instructions in this guide.

**Note:** Installation will take approximately 10–20 minutes, depending on your pre-installed components. Be sure to complete installation of the software before attaching your USB report counter.

Check System Requirements

Before proceeding with the install, check to make sure your system meets the standard requirements.

**Note:** Windows® XP and 2003 users must log in with System Administrator rights to install the software. Windows® Vista®, 7, and 8 users must either log in with System Administrator rights or elevate their credentials via UAC to install the software.

<table>
<thead>
<tr>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Processor: Pentium III or higher</td>
</tr>
<tr>
<td>● Processor Speed: 600 MHz minimum, 1 GHz recommended</td>
</tr>
<tr>
<td>● RAM: 512 MB recommended</td>
</tr>
<tr>
<td>● <strong>Operating System:</strong> Please see our website for supported operating systems (<a href="http://www.PsychCorp.com/qlocal">www.PsychCorp.com/qlocal</a>.)</td>
</tr>
<tr>
<td>● <strong>Hard Drive:</strong> 1 GB of free hard disk space required for StandAlone and Network versions with all three components installed 400 MB of space required for Network version with Client installed 300 MB of space required for Network version with HASP® server only installed</td>
</tr>
<tr>
<td><strong>Note:</strong> Q Local cannot be installed on a compressed drive.</td>
</tr>
<tr>
<td>● <strong>USB Port:</strong> 1 available USB port for the report counter.</td>
</tr>
</tbody>
</table>

Microsoft® SQL Server™ 2008 Express Edition, SP1 R2 is installed with the first-time Q Local installation. Microsoft.NET 4.0 is installed if not already present. A private Java 1.5.0_11 JRE is delivered to a subdirectory of the Q Local installation directory. (This JRE is used by Q Local exclusively and will not affect other applications on your system.)
To find information about your processor speed, RAM, and operating system:

- Right-click on the **My Computer** icon on your computer’s desktop or in the Start menu.
- Then choose **Properties**.

Your computer’s processor speed and RAM will be listed under “Computer” on the **General** tab. The operating system will be listed under “System” on the same tab. If the speed and RAM do not meet the minimum requirements, and/or your operating system is not listed above, you’ll need to upgrade or install Q Local on another computer.

Screen Settings: The minimum screen resolution required is 800 x 600. (To change the screen resolution, click the **Start** button in the lower left corner of your computer’s display, choose **Control Panel**, then **Display**, and finally the **Settings** tab. Move the screen resolution marker to 800 x 600 or higher.)

Scanner: Your computer must have a serial or USB port if you want to attach an OpScan®/iNSIGHT™ scanner. A USB adapter is available from Pearson if your computer has a USB port.

**Note:** If you are using the Q Local Network version, do not install the HASP server or the database server on a machine set to *hibernate, sleep, or power-saver* mode. Doing so will block client access.

---

**Disable Firewall/Anti-Virus/Anti-Spyware Software**

The purpose of security software is to block and interfere with unwanted or malicious software. Unfortunately, security software can also prevent installation and operation of Q Local and its database server, Microsoft® SQL Server® Express.

Check with your security software vendor for configuration instructions. If there is a way to configure your security software to prompt you when it detects a potential threat, choose that option. Then when you are installing or running Q Local, you can choose to allow/unblock/permit all. Otherwise, follow the instructions below.

**Installation:** To prevent your security software from interfering with Q Local or Microsoft SQL Server Express installation, first try disabling the security software. If that doesn’t work, try using the msconfig utility (Start ➔ Run ➔ msconfig ➔ Startup tab) to temporarily disable all software that might interfere with the installation.

**Operation:** After Q Local has been successfully installed, if it does not operate correctly, you might need to configure your security software to allow Q Local and Microsoft SQL Server Express. The executables are:

- `<QLocal_3_Installation_Directory>\QLocal.exe`
- `<QLocal_3_Installation_Directory>\bin\QLocalApp.exe`
- `<QLocal_3_Installation_Directory>\SSEE\MSSQL.n\MSSQL\Binn\sqlservr.exe`

**Note:** `<QLocal_3_Installation_Directory>` refers to the directory where the Q Local program was installed. The default location of this directory is `C:\Program Files\Pearson\Q Local System 3`. 
Check with your security software vendor for configuration instructions.

Once you’ve configured your security software to allow Q Local and Microsoft SQL Server Express, you can re-enable your security software.

If you cannot configure your security software for specific programs, try disabling it completely to allow the operation of Q Local and Microsoft SQL Server Express.

Some security software is so aggressive that it must be completely removed from the machine before Q Local can be installed or run successfully. In some cases, the security software can continue to interfere with Q Local installation or operation even though it appears to be disabled. Check with your security software vendor for removal instructions.

**Note:** Computer vendors frequently sell machines with trial versions of security software. You might not be aware of such add-ons. Check the Add or Remove Programs wizard in the Control Panel for the presence of these add-ons and check with your computer vendor for a list of installed security software components.

---

**Close Any Software Applications**

Close any software that is open.

---

**Installing Q Local 3 (Existing 2.x Customers)**

**Backup Q Local 2.x data**

1. Before installing Q Local 3 please back up data from your existing Q Local 2.x installation via “File ➔ Back Up System” as shown in the picture below.

![Q Local 2.8.6 Home window](image)

2. Identify location of backup outside of Q Local directory. This will avoid deletion of backup during uninstall of Q Local 2.x
3. On successful back up following screen will be displayed

![Image of Q Local 2.x back up screen]

Uninstall Q Local 2.x (XP/Vista/7/8)

Follow instructions below to uninstall Q Local 2.x on operating system applicable to you.

1. Go to the Control Panel.
   - In XP/Vista/7:
     A. Click the Start button.
     B. Select Control Panel.
   - In 8:
     A. On the Start screen, type: control panel
     B. Click the Control Panel tile.

2. View the list of programs.
   - In XP, click the Add or Remove Programs link.
   - In Vista/7/8, under Programs, click the Uninstall a program link.

3. Select Q Local 2.x you want to uninstall.
4. Start the removal process.
   - In XP, to the right of the Q Local 2.x name, click the **Remove** button.
   - In Vista/7/8, above the list of programs, either click the **Uninstall** button or click the **Uninstall/Change** button.

5. If prompted:
   - In Vista, click the **Continue** button.
   - In 7, click the **Yes** button.
   - In 8, click **OK**.

6. Follow the on-screen instructions specific to each program.

**Installing Q Local 3**

1. Insert the Q Local 3 software CD into your CD-ROM drive.
2. If the CD doesn’t start on its own, click on the **Start** button, and then click on **Run**.
3. In the Open box, enter `x:\QDeploy.exe` (replace the “x” with the letter of the drive where your CD is located). Then click on **OK**.
4. The Installer Menu will appear, giving the option of installing audio packages. **Note:** If you choose not to install audio right away, it can be installed later.
5. Follow the instructions on the computer screen. When the instructions ask what “destination location” to use to install the software, choose the **default** (suggested) directory.

**Restore Q Local 2.x data into Q Local 3**

1. Launch Q Local 3.
2. Navigate to “File ➔ Restore System”
3. In the window presented select the file which was backed up before installing Q Local 3
4. Click on “Restore” after selecting the file.
5. You will be notified about the successful completion of restore.
6. On successful restore you will be able to see and use your Q Local 2.x data.
7. Please remember to update the preferences to indicate correct location of back up, TRQ and comparison group files.
Installing or Upgrading Q Local 3 (New or Existing Q Local 3 Customers)

Installing Q Local 3

1. Insert the Q Local 3 software CD into your CD-ROM drive.

2. If the CD doesn’t start on its own, click on the Start button, and then click on Run.

3. In the Open box, enter `x:\QDeploy.exe` (replace the “x” with the letter of the drive where your CD is located). Then click on OK.

4. The Installer Menu will appear, giving the option of installing audio packages. Note: If you choose not to install audio right away, it can be installed later.

5. Follow the instructions on the computer screen. When the instructions ask what “destination location” to use to install the software, choose the default (suggested) directory.

Messages During Installation:

Your computer may display messages or security alerts during the installation. For example:

Message: Security Alert: sqlservr.exe is attempting to connect to the Internet.
What to do: Choose Always Allow Connections… Or if other security alerts are displayed, don’t choose to Block the installation. Choose responses with the words unblock or allow in them.

Message: Setup failed to configure the server. Refer to the server error logs and setup error logs for more information.
What to do: Call Technical Support at 800-627-7271.

Message: If you will not be administering the <assessment> on-screen with audio, you may uncheck the box next to QuickTime Audio Player to shorten your installation time.
What to do: Uncheck the box only if you will not be using the audio function for any assessment. Click OK to continue with the installation.

If something happens that makes you think you need to re-install the software, refer to “How to Re-Install the Software” on page 16 or call Technical Support.

Permissions for Q Local Software

Setting up necessary permissions for Windows operating systems will ensure that users of Q Local software do not experience problems when attempting to create reports, save on-screen tests, and perform other necessary software operations.
Requirements

- To install Q Local 3 software, you must be logged in with System Administrator rights. (If you are the sole user of a system, you probably already have System Administrator rights.)

- To use Q Local 3 software and administer assessments on-screen, we recommend that users have Local Administrator rights.

- System Administrators must give all Q Local users “Full Control” permissions to the install directory (Program Files\Pearson\Q Local System 3) and all sub-directories.

- System Administrators must give all Q Local users “Full Control” permissions to the application data directory (Application Data\Pearson\Q Local System 3) and all sub-directories. To locate the application data directory, click on Start, select Programs and Q Local 3, and click on Access Log Files.

- System Administrators must give all Q Local users “Full Control” permissions to the configuration file (Program Files\Pearson\Q Local System 3\files\b.cfg).

Note to Vista, Windows 7 and Windows 8 Users

Vista allows you to “elevate” your security credentials for a particular program. To do this, right-click on the program and then choose Run as Administrator from the menu. Be aware that using this feature will not block clients from accessing the Ctrl-Alt-Delete functions during on-screen administration and therefore could allow an unsupervised examinee to shut off the computer, switch to another user, or interact with other open programs. (To prevent this, you must be logged into Windows as a Local Administrator.)

Install Internet Explorer for On-Screen Administration

With Q Local software, you can administer tests on-screen. This does not mean online (as in “on the Internet”). Q Local software uses Internet Explorer® software (version 6.0, SP1 or higher) from Microsoft for display purposes only. Q Local software does not connect to the Internet except for specific functions such as ordering report usages online. If your system doesn’t already have Internet Explorer software version 6.0, SP1 or higher installed, the Q Local software installation will inform you that you must install it in order to administer tests on-screen. New versions of Internet Explorer are available on the Microsoft Web site (www.microsoft.com.)

Install QuickTime Audio Player for Audio Administration

Q Local now offers the option of audio administration for select assessments. If your system doesn’t already have an appropriate version of QuickTime installed, the Q Local software installation will inform you that you must install it in order to administer tests with audio. If you will not be using the audio function, you will have the option to deselect QuickTime installation (see page 7, “Messages During Installation”). You may install QuickTime at a later date, if you wish, by re-running the Q Local installation from the CD.
Install Adobe Reader Software

Q Local software uses Adobe Reader® software for reporting. You need this software if you want to view reports on the computer screen or display them in .pdf format. You don’t need this software if you print reports to a printer or save them to files. If your system doesn’t already have Adobe Reader software version 6.0 or higher installed, the Q Local software installation will inform you that you must install it in order to view reports on-screen. You can install Adobe Reader software right from your Q Local CD by choosing Run and then Browse to find the /Adobe/AdbeRdr80_en_US.exe file. Double-click on the AdbeRdr80_en.US.exe file to install the software.

Attach the Report Counter

The report counter is a device that keeps track of the report usages you have in inventory. You must have a report counter attached to the computer you use to generate reports.*

Note: If an earlier version of Q Local was previously installed, Q Local 3 will use the same report counter.

To attach the report counter:

1. Attach the report counter to the computer’s parallel or USB port (depending on which counter you have).

2. If you are using a parallel report counter and you have another device that needs to be attached to the parallel port, attach the report counter directly to the parallel port and then attach the additional device to the other end of the report counter. For example, you can attach the report counter to your computer and then attach a printer cable to the report counter.

Note: If you have a network printer or a printer with a USB cable and you are printing through the USB port, your parallel report counter should be attached directly to the parallel port. Nothing needs to be attached to the other end of the report counter.

DO NOT LOSE - The report counter is your responsibility. If it is lost, stolen or misplaced, Pearson will not refund any of the remaining test administrations.

* Network customers: The report counter can be shared with the computer that is used to generate reports for network installations. See the Additional Information for Network Installations section on page 17 for more information.
Start Q Local Software

To start Q Local software, double-click on the Q icon on your desktop, or click on the Windows Start button, choose Programs, and then choose Q Local 3.

Important How-To Instructions

How to Exit and Save an On-Screen Assessment: Administrator Code

This information about how to stop an online assessment and exit the testing screen is something you won’t want to forget!

- **To stop an incomplete assessment and exit the testing screen**, press the Ctrl and E keys simultaneously. Then enter the code zzz in the field in the Assessment Paused window.
- **To exit the testing screen for a complete assessment**, enter the code zzz in the field in the Assessment Complete window.

You can now change the password for exiting on-screen administration. In the preferences section of Q Local, click the General tab and enter your new password. The new password must be 0 to 8 characters in length. It is not case-sensitive. You can use any character in the password. **Note:** Changing the password will affect all users on the installed system.

**Note Regarding Security and On-Screen Administration**

For optimal security and performance, it is recommended that you shut down all other programs on the computer before a client takes an assessment on-screen. Q Local attempts to lock the keyboard to prevent respondents from using Ctrl-Alt-Delete functions. However, certain characteristics of newer Microsoft operating systems may make it impossible to reliably lock the keyboard.

Under some circumstances, once an on-screen administration is started, you will notice a warning message stating that the keyboard is not locked. If you plan to administer client assessments on-screen, it is your responsibility to supervise the client. Unsupervised clients may be able to shut down the computer, switch to another user, or interact with other open programs.
How to Get Help
Q Local software has two kinds of on-screen help:

- Q Local Help—to get the software up and running with ease
- About Our Assessments—to provide information about each assessment

Both kinds of help are found on the Q Local home window and on the Help menu. Q Local Help includes a quick tour of the software.

How to Check Report Inventory
From the Q Local home window, click on View Report Inventory. This will show you exactly how many usages of each report you have on your counter.

How to Connect the Scanner
The following scanners are supported for Q Local:

<table>
<thead>
<tr>
<th>OpScan iNSIGHT 70</th>
<th>OpScan 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpScan iNSIGHT 150</td>
<td>OpScan 5/6</td>
</tr>
<tr>
<td>5000i</td>
<td>OpScan 7/8</td>
</tr>
<tr>
<td>OpScan 2/iNSIGHT 2 (OMR only)</td>
<td>OpScan 10</td>
</tr>
<tr>
<td>OpScan 4/4U/iNSIGHT 4 (OMR only)</td>
<td>OpScan 15</td>
</tr>
<tr>
<td></td>
<td>OpScan 21</td>
</tr>
<tr>
<td></td>
<td>OpScan 9010M/9020M</td>
</tr>
<tr>
<td></td>
<td>OpScan iNSIGHT 4 with imaging</td>
</tr>
<tr>
<td></td>
<td>OpScan iNSIGHT 2 with imaging</td>
</tr>
</tbody>
</table>

To use an OpScan iNSIGHT scanner to enter data, you must connect it to the computer. Complete illustrated instructions for installing the scanner are found in the scanner’s installation guide. (Also see “How Do I Set Scanner Communications?” in that guide.)

To set up and connect your scanner:

1. Be sure that it is completely assembled.
2. Attach the scanner’s cable to a serial port on your computer.
3. Plug the scanner into an electrical outlet.
4. Be sure the scanner is turned on. (Some OpScan scanners are always on and ready; consult your scanner operator’s guide if you are unsure about this.)

iNSIGHT and OpScan 2, 3, and 4 scanners only: Be sure the communications cartridge is inserted in the scanner just under the input tray (the tray into which forms are fed into the scanner).
How to Transfer Data

Creating a transfer file is the only reliable way to transfer data from one Q Local installation to another. Other methods, such as installation folder hierarchy or individual file copying, cannot be relied upon for accurately transferring Q Local data.

To create a transfer file:

1. From the Q Local Home Page on the original computer, select **Import and Export** from the **File** menu, and choose **Export assessment records to a Q Local Transfer file (*.trq)**. Then click **Next**.

2. Select **Export All Assessment Records** to capture all records. To export only specific records, select the **Export Selected Assessment Records** option.

3. Choose a file name and destination folder for the transfer file. Use the **Browse** button to select an existing file or type in the full path of your desired destination (beginning with the drive letter).

   **Note:** To avoid confusion, you may want to name the file with the same name as the folder that the records originally came from. The path and file names you choose are displayed in the **Transfer File** field.

4. Click the **Export** button. The assessment records are exported to the destination folder as a transfer file (*.trq).

5. Click **OK** to close the Import and Export wizard.

To import files to the second system:

1. From the Q Local Home Page on the **new** computer, select **Import and Export** from the Q Local **File** menu, and choose **Import assessment records from a Q Local transfer file (*.trq)**. Then click **Next**.

2. Click the **Browse** button to navigate to the .trq file that contains the assessment records to be imported.

3. Select the destination folder for the assessment records by clicking on a folder in the database tree. (This folder name should match the folder name used for these records on the first system.)

4. Click the **Import** button. The assessment records are imported to the destination folder.

5. Click **OK** to close the Import and Export wizard.
How to Back Up the System

You should regularly back up your Q Local 3 data using one of the following options:

- Manual Backup
- Backup on Exit
- Q Local Backup Utility

**Manual Backup**

Use the Back Up System option from the File menu. This will back up all of your client data (demographic and test data), software preferences, passwords, and folder structure.

**Note:** You can create transfer files to back up test data only. Choose Import and Export from the File menu. Then choose Export assessment records to a Q Local transfer file (*.trq).

**Backup on Exit**

Upon installation, the Q Local 3 default is set to create a backup file upon exiting the program. This backup is created in the Q Local Application Data Directory. To locate the application data directory, click on Start, select Programs and Q Local 3, and click on Access Log Files.

If you do not want Q Local to create a backup file upon exit, select Change Preferences from the Settings menu. Under the Data Backup tab, select the option “Do not back up my data or remind me.” If you would like to have the backup file created in a different location, keep the default as is and click Browse to select a different location for your data.

**Q Local Backup Utility**

The Q Local Backup Utility is a tool designed to be run from a command line. It is located in the Q Local Installation Directory (QLocalBackup.exe). Running the utility from the command line will create a new backup file in the default location (Application Data\Pearson\Q Local System 3\backups).

Optionally, you can pass it an argument telling it to write the backup file somewhere other than the default location. For example:

QLocalBackup C:savedata\backups

Remember to put quotes around paths that have embedded spaces. For example:

QLocalBackup “D:\My Backups\Q Local”
Caution: This tool is not designed to be used in conjunction with Backup on Exit. You are strongly encouraged to save your backup to another location to avoid any possible interactions with the Q Local Backup on Exit tool. Whenever the Backup on Exit feature creates a backup file, it removes all previous backup files in that location. If you are going to use the Q Local Backup Utility to create regular backups and want to keep them all, be sure to direct your backups to a location other than where the Backup on Exit feature is pointing. Or simply confirm that Backup on Exit has been disabled.

Of Special Interest to Network Administrators

The real usefulness of the Q Local Backup Utility is that there is now a non-interactive way to set up Q Local backups to be run automatically by a task scheduler, such as Windows Task Scheduler.

Note: While the backup utility runs, it will record its progress to the BackRest0.log file in the log subdirectory. If it fails for some reason, it will exit with a non-zero error code. There is no visible indication of whether or not it succeeded unless you decide to check the log. It is recommended that you set the scheduler program to notify you if the file cannot to be written to the intended location.

How to Install Audio

It is still possible to add the audio function after Q Local has been installed.

To install audio using the CD:

1. Close Q Local application.
2. Re-insert your Q Local CD (version 3 or higher).
3. Click on Install Q Local System 3 Audio Packages.
4. Once installation is complete, click on Exit.

Note: Not all assessments contain audio content.
To install audio using the Preferences screen:

1. From the Q Local Home page, click on the **Settings** tab and select **Change Preferences**.

2. Select the **Audio** tab.

3. Check the box of the desired assessment(s) and click on **Download All Selected**.

**Note:** Audio packages can also be removed using this screen.
How to Re-Install the Software

Important Note:

These instructions are not for upgrading your Q Local software. Upgrading your software is accomplished by installing the upgrade ON TOP of your existing software. Upgrade instructions begin on page 3 of this guide. Please note: You will not be able to upgrade from a 2.x version of Q Local to 3. Because of substantial software redesign, a full installation will be necessary. However, this installation will not overwrite data on previously installed versions.

Re-installing Q Local software is done when there are problems with the software you’ve installed and you need to start over from scratch. When re-installing, you actually remove the Q Local software (and the database with the assessment records) from your computer. (See the following instructions.)

Re-installing the software is a three-step process:

1. Back up Q Local data and settings.
2. Uninstall the software.
3. Re-install the software.

Note to Network Users: If you try re-installing the software over your Q Local installation without first uninstalling it, the software will display a window that allows you to modify or remove the software. Select Cancel, confirm the cancellation, select Finish, and remove the CD. Then follow the instructions below.

Back Up Q Local Data and Settings

- **Caution:** If you plan to uninstall your Q Local software and re-install it, you must back up your data and settings first so you don’t lose them. You can restore your data and settings after you re-install Q Local software.
- To back up your Q Local data and settings, follow the instructions under “How to Back Up the System” (page 13).

Uninstall the Software

1. Close any software that is open.
2. Uninstall Q Local software using the Add or Remove Programs function in the Control Panel.

Re-install the Software

- Follow the instructions under “Installing Q Local 3 (Existing 2.x Customers)” (page 4).
Additional Information for Network Installations

Setting Up and Installing the Q Local 3 Network Version Software

Q Local software uses SQL Server 2008 Express Edition (SSEE) and can be installed over an existing TCP/IP network infrastructure to share a central database and report counter with multiple users on a network. We highly recommend installing all components of Q Local 3 software (Client, Shared Database, and Shared Report Counter) on the server first. (We encourage you to leave the client on the server for diagnostic purposes.) Once Q Local software is running on the server, you can install Q Local software clients across your network. (Network configurations and specific instructions to install Q Local follow.) These steps should guide your network installation:

1. Get everything running on the server machine (Client, Shared Database, and Shared Report Counter). Verify that Q Local (the client) can open the home page and that it can view the report usage inventory.

2. Turn off all server firewalls and port-blocking features. Turn off all prospective client machine firewalls and port-blocking features. Q Local software communicates with the database through UDP port 1434 and a dynamically chosen TCP port. Q Local software communicates with the Shared Report Counter through TCP port 1099 (these port references pertain to the server).

3. Use SQLPing (a troubleshooting program in the Utilities folder on the software CD) on a prospective client machine to verify that it can reach the server. The SQLPing command should return information about the server (for example, server name and TCP port). This will indicate that the client machine is able to communicate with the SQL server and that it is ready for a Q Local client installation. (If no information is returned, there is a connectivity problem.)

4. Install Q Local (the client) on the client machine (or workstation) and verify that Q Local software can open the home page and can view the report usage inventory.

Before Installing Q Local 3: If you are performing a side-by-side installation, it is recommended that you first un-install your 2.x report counter server. See page 24 for details.

Note: Do not install the database server or report counter server on a machine set to hibernate, sleep, or power-saver mode. Doing so will block client access.

Network Configurations

When sharing a central database and report counter with multiple users on a network, the network can be configured in a number of ways. The following configuration examples are in order of complexity with the simplest mentioned first:
1. Traditional Client/Server With Single Server for Database and Report Counter

The most common way to set up the network is to use a computer in a server room as the database server and as the report counter server. The server computer is then accessed by the other computers running Q Local software.

2. Traditional Server for Database, but Not for Report Counter

The database server is set up in a server room, but another computer on the network provides access to the report counter. This configuration is recommended when it is difficult to access the server room to connect the report counter. Instead, the report counter is connected to another computer on the network.

**Note:** With this configuration, the machine hosting the report counter server must stay powered on (but a user can still log out).
3. No Traditional Server

No server is set up in a server room. Instead, individual PCs are used, and one is set up as the database server and another (or the same one) is set up as the report counter server. Two examples follow:

![Diagram of Q Local Network Version Software](image)

**Note:** With this configuration, the machine hosting the either database server or the report counter server must stay powered on (but a user can still log out).

### Installing Q Local Network Version Software

To install software on the database server computer:

1. Exit all Windows programs. Disable Internet security software. Install the software by logging into the console if possible. (Access to the report counter will be blocked if you are logged in via Terminal Services or Remote Desktop Connection.)

2. Insert the Q Local 3 software CD into your CD-ROM drive.

3. If the CD doesn’t start on its own, click on the Start button, and then click on Run. In the Open box, enter `x:\QDeploy.exe`. (Replace the “x” with the letter of the drive where your CD is located.) Then click on OK.

4. Follow the instructions on the computer screen. When the instructions ask what “destination location” to use to install the software, choose the default (suggested) directory.

5. When the Select Features window is displayed, leave Q Local Client, Q Local Shared Database, and Q Local Shared Report Counter (assuming this is the machine from which you want to share the report counter) selected. Deselect Q Local Shared Report Counter only if you will be sharing
the report counter from one of the workstations rather than from the database server. Select **Scanning Support** only if you wish to use an OpScan or iNSIGHT scanner at this specific workstation.*

6. Verify that Q Local software is functioning correctly. Open Q Local on the server and be sure that it connects to the database. If Q Local will not open at this point, you will have to troubleshoot this issue before proceeding. Re-enable your security software and be sure Q Local will still connect to the database.

7. If this computer is to host the **Q Local Shared Report Counter**, verify that Q Local software can see the Report Counter. Be sure that the report counter is physically attached. Under **Order**, select **View Report Inventory**. If a list of tests with the number of usages appears, your system can see the counter correctly.

**Note:** The network version of Q Local software is not supported in a virtual server environment.

To install the software on the **individual workstations**:

1. Follow steps 1 through 4 above.

2. When the Select Features window is displayed, deselect **Q Local Shared Database**. Leave **Q Local Shared Report Counter** selected only if you are going to share the report counter from this workstation with other workstations in the network. Deselect **Q Local Shared Report Counter** if the report counter will be hosted by a different computer. Select **Scanning Support** only if you wish to use an OpScan or iNSIGHT scanner at this specific workstation.*

3. The Installer will prompt you for the location of the **Q Local Shared Database** and/or **Q Local Shared Report Counter** if you are not installing them here. Direct Q Local to the appropriate computer on your network by using the IP address or the computer's name on the network.

4. Verify that the client is functioning by following steps 6 and 7 above.

**Report Counter Note:** A Q Local Network client can accommodate more than one report counter. For example, an individual workstation may have a locally attached report counter that is not to be shared with other workstations. Q Local software will first look to the individual workstation to see if there is a locally attached report counter. If a local report counter is not attached, then the software will look for the shared report counter.

* **Scanning Support Note:** Scanners cannot be shared with other computers, so make sure the scanner will be physically attached to your machine before selecting this feature.
Provide Q Local Full Access in Firewall Software

When Q Local software runs, its programs must have access to other programs and files. Your computer’s personal firewall software may block Q Local from accessing resources it needs in order to run. To allow Q Local to operate correctly, you may need to configure your personal firewall software to ensure that Q Local has the access it needs. Refer to page 3 for additional information.

Ports Utilized by Q Local System 3 Network

Make sure the following ports are open on the network and not blocked by any Internet security:

**UDP port 1434**
**TCP port 1099**
**TCP port <server-assigned number>**

The third port is dynamic and selected by your server. To find this port, review “Situation #2” in the following Troubleshooting section (page 22).

Within the firewall software, unblock UDP port 1434. If you don’t know how to do this yourself, call the manufacturer’s technical support line. Tell them you have a software application that works fine when the firewall software is turned off. Also tell them that UDP port 1434 needs to be unblocked to run Q Local software.

**Note for cable modem users:** If your cable modem has a built-in firewall, it may interfere with the operation of Q Local software. Check your modem for any option to unblock Q Local programs or allow them access. You can also try disconnecting your cable modem (the cable end that attaches to your computer) while running Q Local software.

If you have problems running Q Local software (for example, when it attempts to start programs or connect to the database), call Technical Support at 800-627-7271. You may be instructed to allow access to additional Q Local programs.
Troubleshooting the Connection to the Q Local Database

Situation #1: The local client on the server shows the following error: “Connection to Q Local Database failed.”

• Check firewalls. Be sure UDP port 1434 on the server is allowed.

• Allow access to the following programs on the local server within your Internet security software:
  QLocalApp.exe
  QLocal.exe
  SQL Server Windows NT (server only)
  (Refer to page 3 of this guide for specific program paths.)

Situation #2: The local client on the server connects fine, but the remote client shows the following message “Q Local is unable to connect to the database at [computer name/IP address].”

• Verify that the computer name or IP address is correct. Modify if necessary.

• If the problem persists, browse from a command prompt to the Utilities folder on the Q Local System Network version CD. Run SQLPing.exe with the usage format of “SQLPing” followed by the target IP or host name of the server. For example, type SQLPing.exe B436LXP0054 where B436LXP0054 is the computer name of the machine where the server is installed.

X:\Utilities\SQLPing.exe <computer name>  (Note: Omit the angle brackets when you enter the computer name.)

If it can connect to the server, you should see something like the following:

SQL-Pinging xxx.xxx.xxx.xxx
Listening....
ServerName: <computer name>
InstanceName: QLOCAL3INSTANCE
IsClustered: No
Version: 10.50.2500.0
tcp: 1185  (Note: This is a dynamic port number and will vary on your machine.)
np:\<computer name>\pipe\MSSQL$QLocal3INSTANCE\sql\query

If you do not see this, it is possible that something is blocking the communication through your network. You can insert the Q Local 3 CD in the server computer and run the same command to determine which TCP port the database is using.
Troubleshooting the Connection to the Q Local Shared Report Counter

Situation #1: The local client on the server states that the report counter is not connected.

• Check to make sure your report counter is physically connected.


• If you are using a USB report counter, you should see a light in the counter when it is connected. If no light is visible, disconnect and reconnect the report counter. If this problem persists, contact Technical Support at 800-627-7271.

• The HASP® driver will not work if you are logged in through Terminal Services or using a Remote Desktop Connection. This is a security feature of the HASP driver.

Situation #2: The remote client cannot see the shared report counter but the client on the server can.

• Open Q Local on the remote client and click on Help and About the Q Local System. Verify that the “Shared Report Counter from” field is correct. If not, modify as necessary with the Change link.

• Make sure port 1099 is open on your network. This is the port used for the shared report counter.

• Being logged into the server with a Terminal Service causes problems with the connection to the shared report counter. Using Q Local through Terminal Service or using a Remote Desktop Connection is not recommended.

• Although a Q Local Shared Report Counter Windows service is installed to the Services, it is not a true Windows service. It is used simply to get the Shared Report Counter process running when the machine boots. It shows up in Task Manager as a QLocalApp.exe process. Make sure it is started by the system and runs under the Local System account. If it is started by a user and that user logs off the machine, remote clients will not be able to connect to the shared report counter.

• Sometimes you may need to stop and restart the shared report counter. On the server, in the Q Local 3 installation folder, there are two shortcuts to start and stop the Shared Report Counter Service. Note: If your server is running on a Vista machine machine, you will need to right-click on Start Q Local 3 Report Counter and select Run as administrator.

Situation #3: The remote client can see the shared report counter but does not see a locally connected report counter.

Side-by-Side Network Installations for Q Local System 3

When you are installing Q Local System 3 on a machine where Q Local 2.x Network is already installed, Q Local 3 will not overwrite Q Local 2.x. Rather, the two programs will reside side-by-side. Both programs will look at the same report counter via the report counter server. Because this has been updated in Q Local 3, we recommend that you uninstall the report counter server for Q Local 2.x and use the 3.x report counter server. Q Local 2.x clients will be able to use the 3.x report counter server without problems. Please review the following instructions:

1. On the machine where the Q Local 2.x report counter server is installed, insert your Q Local System 2.x CD into the CD-ROM drive. Make sure the first two digits of the version number printed on the CD match those of the Q Local System version number displayed in the Help/About the Q Local System screen. (For example, 2.3 on the CD matches 2.3.14 in the Help/About the Q Local System screen.)

2. The Welcome window will open and ask if you wish to modify, repair, or remove the Q Local System. Make sure that Modify is selected, and then click on Next.

3. When asked which feature to install, deselect the box for Q Local Shared Report Counter and click on Next.

4. The installer will then ask for the location of the shared report counter. Click on Next to accept the default.

5. Click on Finish to exit and install Q Local System 3, following the instructions listed above. Be sure to include the Q Local Shared Report Counter component in your installation. Once the 3.x Shared Report Counter Server is installed, both 3.x and 2.x clients will be able to use that server to connect to the report counter.

Questions?

We hope you find this information helpful. If you have other questions regarding Q Local software, please contact us. For Q Local technical information and Frequently Asked Questions, visit us on the Internet at www.PsychCorp.com/qsupport.